
KEY Description of task

Summary of recommended procedure

Exercise reference(s)

3-D style, apply to objects 13-7
Click object to select. Click 3-D Style button  
on Drawing toolbar and choose style. To 
change settings, choose 3-D Settings and then 
click buttons on 3-D Settings toolbar.

AutoShapes, add text to 13-9
Right-click shape and choose Add Text. Key text.

AutoShapes, align 13-12
Select shapes. Click Draw, Align or Distribute. 
Choose one of the Align options.

AutoShapes, apply fi ll color to 13-7
Click shape to select it. Click Fill Color 
button  on Drawing toolbar and choose 
color. To use fi ll effect, choose Fill Effects and 
click tab (Gradient tab for one- or two-color 
fi lls, Texture tab, Pattern tab, or Picture tab).

AutoShapes, change 13-8
Click shape. Click Draw, Change AutoShape. 
Choose another AutoShape.

AutoShapes, change order of 13-10
Right-click shape and choose Order. Choose 
one of the Send or Bring options.

AutoShapes, copy 13-6
Press and hold Ç  and drag shape.

AutoShapes, delete 13-6
Click shape to select it. Press y .

AutoShapes, distribute 13-12
Select shapes. Click Draw, Align or Distribute. 
Choose one of the Distribute options.

AutoShapes, draw 13-3
Click AutoShapes on Drawing toolbar. Choose 
type of AutoShape. Click specifi c shape and 
then draw.

AutoShapes, fl ip 13-5
Click shape to select it. Choose Draw, Rotate or 
Flip. Choose option.

AutoShapes, format 13-7
Double-click shape. Choose options in Format 
AutoShape dialog box.

AutoShapes, group 13-11
Select shapes. Right-click selection and choose 
Group.

AutoShapes, modify 13-4
Click shape to select it. Drag yellow diamond.

AutoShapes, move 13-4
Click shape to select it. Drag with four-headed 
arrow pointer.

AutoShapes, resize 13-4
Click shape to select it. Drag one of the sizing 
handles.

AutoShapes, rotate 13-5
Click shape to select it. Drag green rotate 
handle.

AutoShapes, ungroup 13-11
Right-click grouped shapes and choose 
Ungroup.

Axis, change font in 20-10
Double-click axis to open Format Axis dialog 
box. Click Font tab. Select desired font options. 
Click OK.

Balance columns 14-11
Position insertion point at end of last column. 
Choose Insert, Break, Continuous to insert con-
tinuous section break.

Body text, show fi rst line of 22-2
Select a heading. Click Show First Line Only 
button  on Outlining toolbar.

Bookmarks, go to 15-9
Choose Edit, Go To or press Ç +G .  Under 
Go to what, choose Bookmark. Under Enter 
bookmark name, click down arrow to see list 
of bookmarks in this document. Choose book-
mark. Click Go To.

AutoCorrect entry, create 6-2
Choose Tools, AutoCorrect Options; key entry 
in Replace box and in With box; click Add. 
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Bookmarks, insert 15-8
Choose Insert, Bookmark. Under Bookmark 
name, key bookmark name. Do not key a space 
between words. Click Add button.

Bookmarks, view 15-8
Choose Tools, Options, View tab. Select Book-
marks. Click OK. 

Borders and shading, use 14-4
Choose Format, Borders and Shading. Click 
appropriate tab and set options.

Browse the Web, download clip art 26-5
Open Insert Clip Art task pane. Click Clips 
Online to open Microsoft Offi ce Design Gallery 
Live. Using Browse or Search for text box, 
whichever is available, key your search word 
and search for clip art. Click any clip to see 
larger preview and list of associated keywords. 
Click preview of clip or down arrow below 
clip to download clip. File is automatically 
downloaded into your Clip Organizer in folder 
within new category called Downloaded Clips.

Character formatting, clear 14-2
Press Ç +ß .

Character spacing, set 14-2
Choose Format, Font, Character Spacing tab. 
Choose scale, spacing, position, or kerning 
options.

Chart gridlines, add 20-6
Select chart. Choose Chart, Chart Options, 
Gridlines tab. Select check box for each gridline 
you want to appear in chart. Click OK.

Chart title, move 20-11
Select title by clicking it. Drag it to new location.

Chart titles, add 20-6
Select chart. Choose Chart, Chart Options, 
Titles tab. Click in Chart title box and type title. 
Type titles for each axis, if desired. Click OK.

Chart type, apply a different type 20-4
Select chart to be modifi ed. On Microsoft 
Graph toolbar, click Chart Type button down 
arrow  and select desired chart type from 
list. To apply a chart sub-type, choose Chart, 
Chart Type, Standard Types tab. In Chart type 
list, select chart type. In Chart sub-type list, 
select sub-type. Click OK.

Chart types, combine 20-5
Select a data series in chart. Choose Chart, 
Chart Type, Standard Types tab. In Chart type 
list, select chart type for selected series. In 
Chart sub-type list, select sub-type. Click OK. 
Repeat for each data series that will have a 
different chart type.

Check box form fi eld, insert 16-5
Position insertion point where you want fi eld to 
appear. Click Check Box Form Field button  
on Forms toolbar.

Clip art, recolor 13-14
Right-click clip and choose Edit Picture. Click 
element of picture that you want to recolor. Use 
Fill Color button  to choose color.

Clip art, rotate or fl ip 13-15
Click clip. Click Draw, Rotate or Flip. Choose 
Rotate or Flip option. If clip is not an in-line 
graphic, drag its rotate handle to rotate.

Column chart, change color of columns in a data series 20-8
Right-click column in the data series and 
choose Format Data Series from shortcut 
menu. When Format Data Series dialog box 
appears, click Patterns tab. Select new color. 
Click OK.

Column layout, create 14-10
Position insertion point. Choose Columns from 
Format menu. Choose options (set Apply to 
box to This point forward or Whole document). 
Click OK.

Column, resize by dragging 19-11
Point to column’s right-hand border. When 
mouse pointer changes to two-headed arrow, 
drag border to resize column. To see column’s 
precise measurement on horizontal ruler, 
press a  as you drag border.

Column, resize by using Table Properties dialog box 19-12
Click in table. Choose Table, Table Properties, 
Column tab. Click Previous Column or Next 
Column button to choose desired column. 
Select Preferred width check box. Specify width 
for column. Click OK.
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Concordance fi le, use to create multiple index entries 23-3
Create new document that contains a two-col-
umn table. In fi rst column, key each word (in a 
separate cell) that you want to include in index. 
In second column, key words as they should 
appear in index. Save and close document. In 
document to be indexed, open Index and Tables 
dialog box and click AutoMark. Select concor-
dance fi le and click Open. 

Cross-reference, create 23-5
Select text to use as main index entry. Open 
Mark Index Entry dialog box. Click Cross-
reference option. In Cross-reference text box, 
type text that will appear in index as cross-
reference. Click Mark.

Custom menu, add commands to 18-16
Right-click any menu or toolbar and choose 
Customize. Click Commands tab. From Save 
in drop-down list, choose fi le to save menu in. 
Under Categories, click Format or other listing. 
On menu bar, click menu you want to custom-
ize. Drag Customize dialog box out of the way 
to see menu. Under Commands, scroll down 
and click and drag command from dialog box 
to menu.

Custom menu, remove new commands from 18-16
Right-click any menu or toolbar and choose 
Customize. Open menu on menu bar and click 
and drag command off of menu.

Data series, plot against different axis 20-7
Right-click data series and choose Format Data 
Series from shortcut menu to open Format 
Data Series dialog box. Click Axis tab. Select 
appropriate axis. Click OK.

Document changes, create bookmark to locate 25-7
Choose Bookmark from Insert menu. Key book-
mark name in Bookmark name text box. Click 
Add to save bookmark.

Document Map, navigate in 22-4
In Document Map pane, click heading to jump 
to that section of document.

Document Map, open and close 22-4
Choose View, Document Map to open Docu-
ment Map pane. Choose View, Document Map 
again to close pane. (Standard toolbar also 
contains a button for Document Map.)

Document, create two versions of 25-6
Make change to original document. Choose 
Versions from File menu. Click Save Now 
button and key a comment. Click OK.

Document, protect from revisions 25-4
Choose Protect Document from Tools menu. 
Choose Tracked Changes. Click OK.

Documents, distribute for revision via e-mail 25-5
Choose Tools, Letters and Mailings, Mail Merge 
Wizard. Mail Merge Wizard opens. Under 
Select document type, choose E-mail mes-
sages. Click Next: Starting Document. Use 
current document and click Next: Select recipi-
ents. Click Browse to locate existing list. Click 
Open. Click OK when Mail Merge dialog box 
appears. Click Next: Write your e-mail mes-
sage. Key message. Click Next: Preview 
your e-mail message. Click Next: Complete 
the merge. Save document. Click Electronic 
Mail to merge to E-mail. Merge to E-mail 
dialog box opens. In To text box, make sure 
Email_Address is selected. In Subject line text 
box, key subject. In Mail format text box, choose 
Attachment. Click OK. Microsoft Outlook will 
launch and send your messages.

Drawing canvas, expand 13-2
Click Expand button  on Drawing Canvas 
toolbar.

Drawing canvas, fi t 13-2
Click Fit button  on Drawing Canvas toolbar.

Drawing canvas, scale drawing on 13-2
Click Scale Drawing button  on Drawing 
Canvas toolbar.

Drawing canvas, use text wrapping on 13-2
Click Text Wrapping  button on  Drawing 
canvas toolbar and choose wrapping option.

Drawing toolbar, view 13-1
Choose View, Toolbars and click Drawing.

Drop-down list form fi eld, insert 16-6
Position insertion point where you want fi eld to 
appear. Click Drop-Down Form Field button  
on Forms toolbar. Click Form Field Options 
button  to open Drop-Down Form Field 
Options dialog box. In Drop-down item text 
box, key items to appear in drop-down list. 
Press e  or click Add button.
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Endnote, convert to footnote 21-8
Select endnote in pane or in Print Layout 
view. Right-click endnote and choose Convert 
to Footnote.

Endnotes, place on separate page 21-9
Insert page break at end of document. Switch 
to Normal view. Display endnote pane by 
choosing View, Footnotes, View endnote area. 
Choose Endnote Separator from drop-down 
list in pane. Delete separator, replace with 
heading such as “NOTES,” and add space 
before and after heading.

Excel chart, embed in Word document 20-2
Place insertion point where chart will appear 
in Word fi le. Open Excel fi le and select chart. 
Choose Edit, Copy to copy chart to Clipboard. 
In the Word fi le, choose Edit, Paste Special. 
In Paste Special dialog box, select Paste option 
and select Microsoft Excel Chart Object. Click 
OK. Click Paste Options button  drop-down 
arrow and click Picture of Chart (smaller fi le 
size).

Excel chart, link to Word document 20-3
Place insertion point where chart will appear 
in Word fi le. Open Excel fi le and select chart. 
Choose Edit, Copy to copy chart to Clipboard. 
In the Word fi le, choose Edit, Paste Special. 
In Paste Special dialog box, select Paste link 
option and select Microsoft Excel Chart Object. 
Click OK. Click Paste Options button drop-
down arrow and click Link to Excel Chart.

Excel data, import into Word chart 20-1
Double-click chart in Word document to acti-
vate Microsoft Graph tools. Click fi rst cell of 
datasheet. Click Import File button  and 
select worksheet fi le to import. In Import File 
Options dialog box, specify worksheet or range 
to import and set other options. Click OK.

Existing Excel worksheet, embed in document 19-28
In Word document, place insertion point where 
you want table to appear. Switch to Excel docu-
ment, select cells whose data will appear in the 
table, and click Copy button . Switch back to 
Word document and choose Edit, Paste Special 
to open Paste Special dialog box. Choose Micro-
soft Excel Worksheet Object from list. Select 
Paste option. Click OK.

Existing Excel worksheet, link to document 19-29
In Word document, place insertion point where 
you want table to appear. Switch to Excel docu-
ment, select cells whose data will appear in the 
table, and click Copy button . Switch back to 
Word document and choose Edit, Paste Special 
to open Paste Special dialog box. Choose Micro-
soft Excel Worksheet Object from list. Select 
Paste link option. Click OK.

Field code view options, set 15-1
Open fi le. Choose Tools, Options, View. Click to 
select Field codes. Click OK.

Field codes, display and hide 19-22
Press a +ª  to display all fi eld codes in docu-
ment. Press a +ª  again to hide codes.

Field properties, change 15-4
Double-click to the left of fi eld. Choose Insert, 
Field. In Field properties section of dialog box, 
choose fi eld format. 

Fields, apply multiple options to 15-5
Double-click to the left of fi eld. Choose Insert, 
Field. In Field properties section of dialog box, 
choose fi eld format. Click Field Codes. Click 
Options and choose appropriate option from 
list. Click Add to Field button. Click OK twice.

Fields, insert 15-2
Choose Insert, Field. Under Categories, choose 
fi eld category. Under Field names, choose fi eld 
name.

Fields, update 15-7
Right-click fi eld and choose Update Field from 
shortcut menu. Or click fi eld and press ª .

Fields, view and edit 15-6
Right-click fi eld and choose Toggle Field Codes 
from shortcut menu. Edit fi eld codes with 
appropriate syntax.

Find and replace formatting or styles 14-9
Choose Replace from Edit menu. Click in Find 
what box and clear text. Click Format to choose 
formatting or style. Do the same in Replace 
with box. Click Find Next. Click Replace.
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Find and replace special characters 14-8
Choose Replace from Edit menu. Enter text or 
special character in Find what box (use Special 
button to choose a character). Do the same 
in Replace with box. Click Find Next. Click 
Replace.

Footnote, convert to endnote 21-7
Select footnote in pane or in Print Layout 
view. Right-click footnote and choose Convert 
to Endnote.

Footnote/endnote, add 21-1
Position insertion point. Press a +Ç +F  
and key footnote text, or choose Insert, Refer-
ence, Footnote.

Footnote/endnote, change number format for 21-10, 21-11
In pane or in Print Layout view, right-click foot-
note or endnote and choose Note options from 
shortcut menu. Open Number format drop-
down list and choose format.

Footnote/endnote, change placement of 21-6
In pane or in Print Layout view, right-click 
footnote/endnote and choose Note options 
from shortcut menu. Choose option in dialog 
box under Location.

Footnote/endnote, copy 21-5
Copy reference mark in document. Paste to 
new location.

Footnote/endnote, delete 21-5
Select reference mark in document. Delete it.

Footnote/endnote, edit or format 21-3
In pane or in Print Layout view, select 
footnote/endnote text. Edit or apply paragraph/
character formatting.

Footnote/endnote, move 21-4
Cut reference mark in document. Paste to new 
location.

Footnote/endnote, view 21-2
To see footnote/endnote text, point to reference 
mark in document and read ScreenTip. Or 
change to Print Layout view or Print Preview.

Footnote/endnote, view in pane 21-2
In Normal view, choose View, Footnotes to 
open footnotes pane. To see endnotes, open 
drop-down list in pane and choose Endnotes.

Form fi eld shading, turn on and off 16-3
Click Form Field Shading button  to turn 
on/off shading.

Form fi eld, add Help text to 16-4
Click within fi eld or select it. Click Form Field 
Options button  on Forms toolbar. Text Form 
Field Options dialog box opens. Click Add Help 
Text button to open Form Field Help Text 
dialog box. Click Status Bar tab, if it is not 
active. In text box under Type your own, key 
help text. Click OK twice.

Form fi eld, choose Number option for 16-4
Click within fi eld or select it. Click Form Field 
Options button  on Forms toolbar. Open 
Type drop-down list and choose Number. Open 
Number format drop-down list and choose 
format. Under Field settings, make sure Fill-in 
enabled option is checked. Click OK.

Form, create a document based on 16-9
Right-click Windows Start button  and 
choose Explore from shortcut menu. In Folders 
list, navigate to folder containing the form. 
Double-click fi le, or right-click fi le and choose 
New from shortcut menu. 

Form, edit 16-11
Click Open button . Choose Document Tem-
plates from Files of type drop-down list. Navi-
gate to folder containing form. Choose form 
template and then click Open button. Unlock 
form and make changes. Resave template or 
Save As to assign a different name.

Form, enter data in 16-10
Click in a fi eld. Key data or choose from a 
drop-down list. Press t  to move to next fi eld.

Form, insert table in 16-12
Use Draw Table button  or Insert Table 
button  to create table in the form.

Form, protect 16-7
Choose Tools, Protect Document; in Protect 
Document dialog box, click Forms option and 
click OK. Or click the Protect Form button  
on the Forms toolbar.

Form, save 16-8
Choose File, Save As. A folder named Tem-
plates should appear in Save in box. Save your 
form as document template with new name.
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Heading, collapse 22-2
Select heading in outline. Either click Collapse 
button  on Outlining toolbar or double-click 
selection symbol  in front of heading.

Heading, demote 22-1, 22-7
Collapse document to show desired heading 
levels. Click heading’s selection symbol to select 
heading and all its subtext. Click Demote 
button  on Outlining toolbar.

Heading, demote to body text 22-1, 22-7
Select heading in outline. Click Demote to 
Body Text button  on Outlining toolbar.

Heading, expand 22-2
Select heading in outline. Click Expand 
button  on Outlining toolbar or double-click 
selection symbol  in front of heading.

Heading, promote 22-1, 22-7
Collapse document to show desired heading 
levels. Click heading’s selection symbol to select 
heading and all its subtext. Click Promote 
button  on Outlining toolbar.

Headings, show multiple levels 22-2
Click Show Level button drop-down 
arrow  on Outlining toolbar. Select 
lowest heading level you want to appear in out-
line. Word hides all headings and body text 
below the level you select.

HTML format, round-trip document from 26-10
Open HTML document. Choose Save As from 
File menu. Open Save as type drop-down list 
and choose Word Document. Click Save. 

HTML, convert document to 26-7
Open fi le. Choose File, Save as Web Page.

Hyperlink to a Web site, create 26-4
Key Web site address. Word automatically cre-
ates  hyperlink.

Hyperlink to another document, create 26-2
Select word or phrase to use as hyperlink. Click 
Insert Hyperlink button  or press Ç +K . 
In Insert Hyperlink dialog box, under Link to, 
click Existing File or Web Page. Click Current 
Folder if it is not active. In Look in text box, 
locate and click fi le to link to. The fi lename 
appears in Address text box. Click OK.

Hyperlink, insert bookmark  26-1
Create bookmark. Select word or phrase to use 
as hyperlink. Click Insert Hyperlink button  
or press Ç +K . Under Link to, click Place in 
This Document button. Under Bookmarks, click 
bookmark name. Click OK.

Hyperlink, insert by using Copy and Paste as Hyperlink 26-1
Copy text to become a hyperlink. Position 
insertion point where you want hyperlink. 
From Edit menu, choose Paste as Hyperlink.

Hyperlink, insert heading  26-1
Style heading. Select word or phrase to use as 
hyperlink. Click Insert Hyperlink button  or 
press Ç +K . Under Link to, click Place in 
This Document button. Under Headings, click 
heading name. Click OK.

Index entry, create  23-1
Select text to be used for main index entry. 
Press a +s +X  to open Mark Index Entry 
dialog box. Click Mark.

Index entry, use range of pages in 23-4
Select all text to be covered by index entry, 
Create bookmark for selected text. Place inser-
tion point at end of bookmarked text. Open 
Mark Index Entry dialog box. Click in Main 
entry box and key main index entry. Click Page 
range and select desired bookmark from Book-
mark list. Click Mark.

Index subentry, create 23-2
Select text to be used for main index entry. 
Press a +s +X  to open Mark Index Entry 
dialog box. Click Subentry text box and key text 
to be used as  subentry. Click Mark.

Index, add to master document 24-11
Place insertion point at end of master docu-
ment, but not within a subdocument. Choose 
Insert, Reference, Index and Tables, Index tab. 
Select desired options for your index. Click OK.

Index, compile and format 23-6
Place insertion point on blank line at end 
of document. Open Index and Tables dialog 
box. Click Index tab. Select desired formatting 
options. Click OK.
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Index, edit and update 23-7
In document, make changes to one or more 
index entry fi elds. Right-click index and choose 
Update Field from shortcut menu, or press ª .

Legend, change font options in 20-9
Select legend. Choose Format, Selected Legend 
to open Format Legend dialog box. Click 
Font tab. Select font options for legend’s text. 
Click OK.

Legend, remove borders from 20-9
Select legend. Choose Format, Selected Legend 
to open Format Legend dialog box. Click Pat-
terns tab. Under Border, click None. Click OK.

Legend, reposition in a chart 20-9
Select legend. Choose Format, Selected Legend 
to open Format Legend dialog box. Click Place-
ment tab. Select position for legend. Click OK.

Line chart, change  color of markers in data series 20-8
Right-click line in data series and then choose 
Format Data Series from shortcut menu. When 
Format Data Series dialog box appears, click 
Patterns tab. Under Marker, select new fore-
ground and/or background color. Click OK.

Line chart, change color of lines in data series 20-8
Right-click line in data series and then choose 
Format Data Series from shortcut menu. When 
Format Data Series dialog box appears, click 
Patterns tab. Under Area, select a new color. 
Click OK.

Line, draw 13-1
Click Line button  on Drawing toolbar. Draw 
line in drawing canvas. To draw a straight line, 
hold s  as you draw.

Link text boxes 14-13
Draw text box. Insert text. Draw second text 
box. Click in fi rst text box. Click Create Text 
Box Link button  on Text Box toolbar. Click 
in second text box to fl ow text.

Link, edit to make documents portable 19-30
Press a +ª  to display fi eld codes. Find code 
for linked worksheet. Edit it to remove all 
the fi le’s path information. Leave fi le’s name 
intact in fi eld code. Press a +ª  again to hide 
fi eld codes.

List style, create 14-6
Display Styles and Formatting task pane (Format, 
Styles and Formatting). Click New Style, choose 
List as style type, and choose options. To create a 
bulleted list, click Bullets button  and choose 
symbol character for each list level.

List, sort 19-19
Select list. Choose Table, Sort to open Sort Text 
dialog box. (If you want Word to recognize 
each word as a separate fi eld, click Options to 
open Sort Options dialog box. Under Separate 
fi elds at, specify the character that separates 
words, such as a blank space. Click OK.) In 
Sort by list, choose word or fi eld on which to 
sort. In Type list, choose Text. Click Ascending 
or Descending option. Click OK.

Macro, assign keyboard shortcut to 18-14
Choose Tools, Customize. Click Keyboard button. 
Under Categories, scroll to bottom of list and 
choose Macros. Make sure your template fi le is 
selected from Save changes in list box. Under 
Macros, choose macro name. In Press new 
shortcut key box, press keyboard combination. 
Click Assign. Click Close. Click Close again.

Macro, copy individual 18-11
Open Macros dialog box. Select macro to 
be copied. Click Edit button. Select all text 
in macro. Click Copy button  on Visual 
Basic Standard toolbar. Go to bottom of code 
window and position insertion point on blank 
line below last macro. Click Paste button  on 
Visual Basic Standard toolbar. 

Macro, create AutoText entry to use with 18-1
Open template fi le. Create AutoText entries. 
Resave template fi le or save it with new name.

Macro, delete 18-13
Open Macros dialog box. Select macro to 
be deleted. Click Delete button. Click Yes. 
Click Close.

Macro, edit 18-7
Choose Tools, Macro, Macros or press a +• . 
In Macros in text box, choose template contain-
ing macro. Choose macro from list above and 
click Edit. In Visual Basic Editor window, make 
changes to macro code. Click Save button . 
Then choose File, Close and Return to Micro-
soft Word, or press a +Q .



Word 2002: Expert 8 Task Reference List

Macro, prepare to record 18-2
Choose Tools, Macro, Record New Macro. In 
Macro name text box, key macro name. Under 
Store macro in, choose Documents Based On. 
In Description box, edit text to indicate that you 
recorded macro. Press e  to start new line 
and then key a description of what the macro 
does. Click Keyboard button. With insertion 
point in Press new shortcut key text box, press 
a keyboard shortcut (for example, a +1 ). 
Click Assign button. Click Close.

Macro, record 18-3
Using recording pointer, choose commands 
that you want macro to perform. Click Stop 
Recording button .

Macro, rename 18-12
With Visual Basic window open, select macro 
name inside quotation marks and key new 
name. Click Save button .

Macro, run 18-5
Choose Tools, Macro, Macros. Make sure cor-
rect template is selected in Macros in list box. 
Select macro. Click Run.

Macro, set security 18-4
Choose Tools, Macro, Security. Display Security 
Level tab. Choose security level. Click OK.

Macro, use letter template macros to create letter 18-9
Start new document based on template. Click 
Enable Macros. Run macros. Save template as 
a letter.

Macros, copy 18-10
Open template fi le. Press a +•  to open 
Macros dialog box. Click Organizer button. In 
Organizer dialog box, click Macro Project Items 
tab. On right side of dialog box, click Close 
File. Click Open File on right side of dialog 
box and navigate to folder containing fi le with 
macros. Click Open. Make sure NewMacros is 
selected in list on right side, and then click 
Copy button to copy all macros in NewMacros 
module to list on left side. The left and right 
side might be reversed depending on what fi le 
you are copying to. Click Close.

Mail Merge, complete merge 17-5
In Mail Merge wizard task pane, click Next: 
Complete the merge, and click Print to merge 
to printer or click Edit individual letters to 
merge to new document. Or click Merge to New 
Document button  on Mail Merge toolbar.

Mail Merge, create data source 17-2, 17-3
In Mail Merge wizard task pane, click Next: 
Select Recipients. Choose Type a new list. 
Click Create (fi elds can be added, deleted, and 
renamed). Key data for records. Click New 
Entry after each new record entered.

Mail Merge, create labels 17-12
Open new document. Choose Tools, Letters and 
Mailings, Mail Merge Wizard. Choose Labels 
as document type. Choose starting document 
and label options (type and size). Choose 
data source. Arrange labels by inserting merge 
fi elds. Click Update all labels button. Preview 
and complete the merge.

Mail Merge, create main document 17-1
Choose Tools, Letters and Mailings, Mail Merge 
Wizard; choose document type; click Next: 
Starting document; select starting document. 
Or display Mail Merge toolbar and click Main 
document setup button .

Mail Merge, edit main document 17-9
Open document. Edit text as needed. Use Insert 
Merge Fields button  on Mail Merge toolbar 
to insert new fi elds. Use View Merge Data 
button  and Next Record button  to pre-
view merged records.

Mail Merge, fi lter data source 17-11
Open data source fi le. Use Mail Merge Recipi-
ents button  to open Mail Merge Recipients 
dialog box. Click down arrow next to a column 
heading and choose records you want to fi lter.

Mail Merge, insert merge fi elds 17-4
In Mail Merge wizard task pane, click Next: 
Write your letter; choose Address Block, Greet-
ing Line, or More items. Or click Insert Merge 
Fields button  on Mail Merge toolbar.
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Mail Merge, preview merged data 17-5
In Mail Merge wizard task pane, click Next: 
Preview your letters and click double-arrows to 
preview each record. Or click View Merge Data 
button  on Mail Merge toolbar.

Mail Merge, sort data source 17-10
Open data source fi le. Use Mail Merge Recipi-
ents button  to open Mail Merge Recipients 
dialog box. Click column name heading to 
sort list. Click down arrow next to a column 
heading and choose (Advanced…). Click Sort 
Records tab and in Then by drop-down list 
choose second sort option.

Mail Merge, use Excel data source 17-7
Click Open Data Source button . Locate 
Excel fi le and open it. Use Mail Merge Recipi-
ents button  to view records. Click Merge to 
New Document button .

Mail Merge, use Outlook data source 17-8
Choose Tools, Letters and Mailings, Mail Merge 
Wizard. Click Select from Outlook contacts. 
Click Choose Contacts Folder. Click OK to 
accept Outlook as Profi le Name. Click OK to 
choose Contacts Personal Folders. Click OK to 
choose recipients from Outlook. Use Merge to 
New Document button  to merge records. If 
Invalid Fields dialog box appears, replace fi elds 
with fi elds from Outlook data source.

Mail Merge, use Word data source 17-6
Click Open Data Source button . Locate 
Word fi le and open it. Use Mail Merge Recipi-
ents button  to view records. Click Merge to 
New Document button .

Master document, lock 24-4
Place insertion point in master document, but 
not in a subdocument. For example, click 
within section break before fi rst subdocument 
to place insertion point there. Click Lock Docu-
ment button .

Merge documents 25-3
Choose Tools, Compare and Merge Documents. 
In Compare and Merge Documents dialog box, 
locate another revision of same fi le. Click Merge 
down arrow and choose Merge into current doc-
ument. Word merges new fi le into currently 
open fi le and displays revision marks identifying 
changes between revised fi le and original fi le.

Nested tables, create multiple 19-16
Select fi rst table you want to nest (and its cap-
tion). Drag it into an empty cell of parent table. 
Repeat for any other tables to be nested.

New Excel worksheet, embed in document 19-24
In Word document, place insertion point where 
you want Excel worksheet to appear. Click 
Insert Microsoft Excel Worksheet button . 
When grid appears below button, drag to set 
number of rows and columns for sheet. When 
you release mouse button, worksheet appears 
in document and Excel tools are added to 
Word’s menu bar and toolbars.

New Excel worksheet, enter data and navigate 19-25
Click in cell and key data. Use mouse or arrow 
keys to move insertion point to another cell. 
Click outside worksheet to turn off Excel tools. 
Double-click worksheet to reactivate Excel 
tools.

Outline view, switch to 22-1
Click Outline View button  on horizontal 
scroll bar.

Outline, copy and paste text in 22-6
Collapse document to show desired heading 
levels. Click heading’s selection symbol to select 
heading and all its subtext. Choose Edit, Copy 
or click the Copy button  to copy selected 
text to Clipboard. Place insertion point where 
the copy will go. Choose Edit, Paste or click the 
Paste button  to insert the copied text.

Outline, delete text in 22-6
Collapse document to show desired heading 
levels. Click heading’s selection symbol to select 
heading and all its subtext. Press y .

Outline, move text by dragging 22-5
Collapse document to show desired heading 
levels. Click heading’s selection symbol to select 
heading and all its subtext. Move selected text 
to new location by clicking Move Up button  
or Move Down button  on Outlining toolbar. 
Or you can move selected text by pointing 
to its selection symbol; when mouse pointer 
changes to four-headed arrow, drag text to its 
new location.
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Outline, navigate in 22-3
Click Select Browse Object button . Click 
Browse by Heading button . Click Next 
Heading button  to jump to next heading in 
outline, or click Previous Heading button  to 
jump to previous heading in outline.

Oval, draw 13-1
Click Oval button  on Drawing toolbar. Draw 
oval in drawing canvas. Hold s  as you draw 
to create a circle.

Paragraph formatting, clear 14-3
Press Ç +Q .

Paragraphs, sort 19-20
Select paragraphs to sort. Choose Table, Sort. 
In Sort Text dialog box, under Sort by, choose 
Paragraphs. In Type drop-down list, choose 
Text. Click Ascending or Descending option. 
Click OK.

Photographs, insert 13-16
Click Insert Clip Art button  on Drawing 
toolbar. In Search text box, enter keyword. 
Open Results should be drop-down list, select 
Photographs, and clear all other check boxes. 
Click Search. Click thumbnail to insert.

Photographs, resize 13-17
Double-click photograph. Use Size tab to 
 specify size.

Plot area, change color of 20-8
Right-click plot area and then choose Format 
Plot Area from shortcut menu. When Format 
Plot Area dialog box appears, click Patterns 
tab. Select new color. Click OK.

Position objects 13-22
Double-click object. Click Layout tab. Click 
Advanced. Click Picture Position tab. Under 
Horizontal, choose alignment type and what 
object is relative to. Under Vertical, do the 
same. Click OK twice.

Pull quote, create 14-12
Select text. Click Text Box button  on Draw-
ing toolbar. Format text box as desired.

Rectangle, draw 13-1
Click Rectangle button  on Drawing toolbar. 
Draw rectangle in drawing canvas. Hold s  
as you draw to create a square.

Row, resize by dragging 19-11
Point to row’s bottom border. When mouse 
pointer changes to double-headed arrow, drag 
border to resize row. To see row’s precise mea-
surement on vertical ruler, press a  as you 
drag border.

Row, resize by using Table Properties dialog box 19-12
Click in table. Choose Table, Table Properties 
to open Table Properties dialog box. Click Row 
tab. Click Previous Row or Next Row button to 
choose desired row. Select Specify height check 
box. Specify a height for the row. Click OK.

Rows, keep together at page break 19-13
Select fi rst of two rows you want to keep 
together. Choose Format, Paragraph, Line and 
Page Breaks tab. Select Keep with next check 
box. Click OK.

Secondary axis, add 20-7
Select chart. Choose Chart, Chart Options to 
open Chart Options dialog box. Click Axes tab. 
Select check box for each secondary axis you 
want to add to chart. Click OK.

Shadow, apply to objects 13-7
Click object to select. Click Shadow Style 
button  on Drawing toolbar. Choose style. To 
change settings, choose Shadow Settings; then 
click buttons on Shadow Settings toolbar.

Starting page number, change 14-15
In header or footer pane, click Format Page 
Number button . Change option under Page 
numbering.

Style, create 14-5
Display Styles and Formatting task pane 
(Format, Styles and Formatting). Click New 
Style. Choose options (including style type—
paragraph, character, list, or table). Click OK. 

Styles, modify 14-7
Right-click style name in Styles and Formatting 
task pane and choose Modify. Choose options. 
Click OK.

Subdocument, create from existing document 24-2
Switch to Outline view. Show desired heading 
levels. Select heading and its subtext. Click 
Create Subdocument button  on Outlining 
toolbar.
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Subdocument, create from headings in Outline View 24-1
Switch to Outline view. Create heading. Select 
it. Click Create Subdocument button  on 
Outlining toolbar.

Subdocument, insert into master document 24-3
Place insertion point where you want new sub-
document to appear in master document. Click 
Insert subdocument button . In Insert Sub-
document dialog box, select document to be 
inserted. Click Open.

Subdocument, lock 24-4
Place insertion point in subdocument. Click 
Lock Document button .

Subdocument, move 24-6
Expand one or more subdocuments so their 
section breaks are visible. Click subdocument 
symbol  next to subdocument you want to 
move. Drag subdocument symbol up or down; 
a gray horizontal line appears to show subdoc-
ument’s location. When line appears between 
desired subdocuments’ section breaks, drop it.

Subdocument, open in separate window 24-1, 24-5
Do one of the following: (A) If subdocument’s 
heading is visible, double-click subdocument 
symbol  for desired subdocument. (B) If 
subdocument is displayed as a hyperlink, press 
Ç  and click hyperlink.

Subdocument, remove 24-9
Select subdocument you want to remove from 
master document. Click Remove Subdocument 
button . If you want to delete former subdoc-
ument’s text from master document, leave it 
selected and press y .

Subdocument, split 24-7
Position insertion point where you want to 
split subdocument. Click Split Subdocument 
button .

Subdocuments, collapse 24-1
In master document, click Collapse Subdocu-
ments button .

Subdocuments, merge 24-8
Select subdocuments you want to merge. Click 
Merge Subdocument button .

Table form, enter data in 16-15
Navigate to fi elds by using t . Enter data.

Table of contents, add to master document 24-10
Place insertion point at top of master docu-
ment, but not within a subdocument. Choose 
Insert, Reference, Index and Tables, Table of 
Contents tab. Select desired options for your 
table of contents. Click OK.

Table of contents, create  23-8
Make sure Heading styles are applied to all 
headings in document. Place insertion point 
where table of contents should appear. Open 
Index and Tables dialog box. Click Table of 
Contents tab. Click OK.

Table of contents, edit and update 23-10
Make changes to headings or other text in 
document that might affect page numbering. 
Click next to table of contents (in right or left 
margin) and press ª . Select Update entire 
table option. Click OK.

Table of contents, format 23-9
Place insertion point in table of contents. Open 
Index and Tables dialog box. Click Table of 
Contents tab. Select formatting option from 
Formats list box. Select leader style from Tab 
leader list. Click OK twice to apply changes to 
table.

Table style, create 19-9
Click in table. Display Styles and Formatting 
task pane. Click Show drop-down arrow and 
choose All styles. Click New Style to open 
New Style dialog box. Specify name for new 
style in Name box. Click Style type drop-down 
arrow and choose Table. Click Apply formatting 
to drop-down arrow and select a part of the 
table (or entire table) to format. Set formatting 
options for selected portion of table. Select and 
format different parts of the table, as needed. 
Click OK. Find new style’s name in task pane. 
Click it to apply it to table.

Table style, modify 19-9
Click in table. Choose Table, Table AutoFormat 
to open Table AutoFormat dialog box. Choose 
Modify to open Modify Style dialog box. Select 
any portion of table and change its formatting. 
Click OK. When Table AutoFormat dialog box 
reappears, click Apply.
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Table, add caption to 19-10
Click in table’s fi rst row. Choose Insert, Refer-
ence, Caption. In Caption dialog box, edit text 
in Caption text box. Click OK.

Table, adjust height of 19-17
Select table. Choose Table, Table Properties, 
Row tab. Deselect Specify Height check box. 
Click OK. Drag table’s resize handle upward or 
downward to adjust its height. Table’s rows will 
adjust proportionately to table’s overall height.

Table, AutoFit to Contents 19-8
Select table. Choose Table, point to AutoFit, and 
then choose AutoFit to Contents. Table’s column 
widths are adjusted to best fi t their contents.

Table, AutoFit to Window 19-10
Click in table. Choose Table, AutoFit, AutoFit to 
Window. Table expands horizontally to fi ll page.

Table, AutoFormat 19-8
Click in table. Choose Table, Table AutoFormat. 
Select All table styles from Category list. In 
Table styles list, select style. Under Apply spe-
cial formats to, select check boxes for portions 
of the table that should receive special formats 
for selected style. Click Apply.

Table, calculate average values in row or column 19-22
Click in the table cell that will display the 
result. Choose Table, Formula to open Formula 
dialog box. Delete all text in Formula box 
except the equals sign (=). Click Paste function 
drop-down arrow and choose AVERAGE. In 
the parentheses following the function’s name, 
type a bookmark (such as ABOVE or LEFT), 
the addresses of the individual cells to be aver-
aged (such as B3,C3,D3), or the cells’ range 
(such as B3:D3). Select a format from the 
Number format list. Click OK.

Table, calculate total values in row or column 19-23
Click in table cell that will display result. 
Choose Table, Formula to open Formula dialog 
box. Delete all text in Formula box except the 
equals sign (=). Click Paste function drop-down 
arrow and choose SUM. In parentheses follow-
ing the function’s name, type bookmark (such 
as ABOVE or LEFT), addresses of individual 
cells to be totaled (such as B3,C3,D3), or the 
cells’ range (such as B3:D3). Select format from 
Number format list. Click OK.

Table, change all cell margins 19-6
Select table. Choose Table, Table Properties, 
Table tab. Click Options button. Set left, right, 
top, and bottom margins. Click OK twice.

Table, change single cell’s margins 19-6
Select cell. Choose Table, Table Properties, Cell 
tab. Click Options button. Clear Same as the 
whole table check box. Set left, right, top, and 
bottom margins. Click OK twice.

Table, change vertical alignment in cells 19-7
Select table. Choose Table, Table Properties, 
Cell tab. Under Vertical alignment, choose 
alignment setting. Click OK.

Table, control page breaks in 19-1
Select table. Choose Table, Table Properties, 
Row tab. Clear Allow row to break across 
pages check box. Click OK.

Table, create from Excel worksheet 19-27
In Word document, place insertion point where 
you want table to appear. Switch to Excel docu-
ment, select cells whose data will appear in 
table, and click Copy button . Switch back to 
Word document and click Paste button .

Table, defi ne heading row 19-2
Select row or rows that will repeat at top of 
each page where table appears. Choose Table, 
Heading Rows Repeat.

Table, draw with gridlines 19-15
Display Drawing toolbar. Click Draw button. 
Click Grid. In Drawing Grid dialog box, select 
Snap objects to grid and Display gridlines 
on screen check boxes. Click OK. Using 
pointer, draw table on screen by dragging to 
create cells.

Table, insert form fi elds for calculation in 16-13
Move to appropriate cell in table. Click Text 
Form Field button  on Forms toolbar. Click 
Form Field Options button . Under Type, 
choose Number. In Default number text box, 
key number 0. Click Calculate on exit check box 
to select that option. Click OK.

Table, insert text above 19-5
If there is no blank paragraph mark above 
table, click in table’s fi rst cell. Choose Table, 
Split Table. Click newly inserted paragraph 
mark and type your text.
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Table, resize proportionately 19-14
Click in table. Rest mouse pointer over table 
so table resize handle appears. Point to table 
resize handle. When mouse pointer changes 
to two-headed arrow, drag handle in desired 
direction to resize table.

Table, sort on multiple columns 19-18
Click in table you want to sort. Choose Table, 
Sort. In Sort dialog box, specify fi rst column on 
which to sort, specify type of sort, and select 
Ascending or Descending. Specify second (and 
third, if desired) column on which to sort, and 
set its sorting options. Click OK.

Table, sort on one column 19-18
Click in column on which you want to sort 
table. Display Tables and Borders toolbar. 
Click either Sort Ascending button  or Sort 
Descending button .

Table, split 19-4
Click in row that will become fi rst row of new 
table. Choose Table, Split Table.

Table, turn off heading rows 19-3
Select table’s heading row or rows. Choose 
Table, Heading Rows Repeat.

Table, use AutoSum in 16-14
Move to appropriate cell in table. Click Auto-
Sum button  on Tables and Borders toolbar.

Template, create new 16-1
If New Document task pane is not open, choose 
File, New to open it. Under New from template, 
click General Templates and the Templates 
dialog box opens with Blank Document high-
lighted. Under Create New, choose Template (in 
the lower-right corner). Blank Document might 
change to gray. Click OK.

Template, save document as 13-26
Choose File, Save As. In File name box, key 
template name. From Save as type list, choose 
Document Template. Click Save.

Text box, change direction of text in 13-21
Click border of text box. Click Change Text 
Direction button  on Text Box toolbar.

Text box, delete 13-20
Click border of text box. Press y .

Text box, format 13-20
Right-click border of text box, choose Format 
Text Box, click tab, and choose options. Or 
select text box and use buttons on Drawing 
toolbar. 

Text box, insert 13-18
Click Text Box button  on Drawing toolbar 
and draw text box in drawing canvas. Or press 
q  to delete drawing canvas and then draw 
text box.

Text box, select 13-19
Click border of text box.

Text box, size 13-19
Click border of text box and drag a handle to 
resize. To resize to exact measurement, double-
click border and use Size tab of Format Text 
Box dialog box.

Text fl ow options, apply 14-11
Select text. Choose Format, Paragraph, Line 
and Page Breaks tab. Choose Keep with next 
to keep two paragraphs together, choose Keep 
lines together to keep lines of a paragraph 
together, or choose Page break before to start a 
paragraph at a new page.

Text form fi eld, insert 16-3
Position insertion point where you want fi eld 
to appear. Click Text Form Field button  on 
Forms toolbar. 

Text wrapping, apply to objects 13-2, 13-23
Click Text Wrapping button  for object, if 
available, and choose option. Or double-click 
object, click Layout tab, click Advanced, click 
Text Wrapping tab. Under Wrapping style, 
choose option. Under Wrap text, choose option. 
Click OK twice.

Toolbar, add buttons to 18-17
Right-click any toolbar and choose Customize. 
Click Toolbars tab. Click New. Key toolbar 
name. Click OK. Drag Customize dialog box 
out of the way to see new toolbar. Click Com-
mands tab. In Categories list, select category 
of buttons. In Commands list, locate button 
you want and drag it onto new toolbar. Close 
Customize dialog box.
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Toolbar, delete 18-17
Open Customize dialog box. Display Toolbars 
tab. Select toolbar from list. Click Delete. Click 
OK when asked if you’re sure you want to delete 
toolbar. Close Customize dialog box.

Toolbar, remove buttons from 18-17
Open Customize dialog box. Drag button 
off toolbar to remove it. Close Customize 
dialog box.

Track changes, accept 25-2
Click revision and click Accept Change 
button  on Reviewing toolbar to accept 
change. Or right-click revision and choose 
Accept Insertion or Accept Deletion from 
shortcut menu.

Track changes, accept all 25-2
Choose Tools, Track Changes. Click Accept 
Change button down arrow . Choose Accept 
All Changes in Document.

Track changes, enter revision marks 25-1
Turn on Track Changes mode: double-click 
“TRK” on status bar, or choose Tools, Track 
Changes, or click Track Changes button  on 
Reviewing toolbar. 

Track changes, move to next revision 25-2
Click Next button  on Reviewing toolbar.

Track changes, reject 25-2
Click revision and then click Reject Change/
Delete Comment button  on Reviewing 
toolbar. Or right-click revision and choose 
Reject Insertion or Reject Deletion from 
shortcut menu.

Track changes, reject all 25-2
Choose Tools, Track Changes. Click Reject 
Change/Delete Comment button down 
arrow . Choose Reject All Changes in 
 Document.

Unlink section headers/footers 14-15
Choose View, Header and Footer to open 
Header pane. If unlinking footer, click Switch 
Between Header and Footer button . Use 
Show Next button  to go to section you want 
unlinked. Click Same as Previous button  to 
break link. 

Watermark, create from picture 13-24
For clip already inserted, click Color button  
on Picture toolbar, choose Washout, and send 
picture behind text. Or choose Format, Back-
ground, Printed Watermark, Picture watermark, 
Select Picture; then navigate to folder/picture 
fi le, click picture, click Insert, and click OK.

Watermark, create from text 13-25
Choose Format, Background, Printed Water-
mark, Text watermark. Choose option from Text 
drop-down list or key text. Click OK.

Web page, add a frame 26-9
In Web page, choose Format, Frames, New 
Frames Page. Frames toolbar opens. Word 
opens new document with the Web page con-
tent in it. Click New Frame button (Left, Right, 
Above, or Below). Add text, images, or buttons 
in your new frame.

Web page, create using Web Page Wizard 26-6
Choose File, New. Click General Templates, and 
then click Web Pages tab. Select Web Page 
Wizard and click OK. Click Next to display 
Title and Location dialog box. In Web site title 
text box, key Web page title. Set Web site loca-
tion to your Lesson folder (use Browse button, 
if needed). Click Next. In Navigation dialog 
box, choose navigation type. Click Next. In 
Add Pages dialog box, click Blank Page 2, if 
it is not highlighted, and then click Remove 
Page, if you want to remove the second page. 
Click Next. In Organize Pages dialog box, click 
Next. In Visual Theme dialog box, click Browse 
Themes. Click theme you want to apply and 
then click OK. Click Next. Click Finish.

Web page, format 26-8
Use standard formatting commands to format 
Web page. Add a background, bulleted list, 
and any type of formatting you wish. To add 
scrolling text, open Web Tools toolbar and click 
Scrolling Text button . Key scrolling text in 
text box. Change Background color of scrolling 
text if you want. Click OK.


